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CHAPTER 14 CHARTING TECHNIQUES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

When you create a chart in Excel, it’s produced with a default layout 
and appearance. You can modify the layout, by adding labels and 
other features, to improve its appearance and readability. 

In this session you will: 

 gain an understanding of chart layout elements 

 learn how to add a chart title 

 learn how to add axes titles 

 learn how to position the legend 

 learn how to show data labels 

 learn how to show a data table 

 learn how to modify the horizontal and vertical axes 

 learn how to show or hide gridlines 

 learn how to format the plot area 

 learn how to add a trendline 

 learn how to add error bars to a chart 

 learn how to add a text box to a chart 

 learn how to draw shapes in a chart. 

INFOCUS 

WPL_E829 
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UNDERSTANDING CHART LAYOUT ELEMENTS 
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Microsoft Excel provides a range of chart 
elements that can be added to the layout or used 
to modify the layout so that the chart is easier to 
interpret. Charts can be used to communicate a 

range of ideas, and chart layout elements help 
you emphasise particular ideas, information and 
trends. This page takes an introductory look at the 
elements that you can take advantage of. 

Chart Layout Elements 

The chart above has been overladen with chart layout elements so that you can see how they fit in 
and work together. In reality, you would only ever use a few at a time to avoid confusion. 


The chart title appears at the top of the 
chart and explains it purpose. Textual 
elements like this can be edited and 
moved to any location required. 


The horizontal (x) and vertical (y) axes 
show the scale of the chart or nominate 
the data elements. In this example, the 
x-axis is hidden by the data table.  


The axes titles give an overview of the 
data that is plotted on the chart. 

Horizontal and vertical gridlines can be 
drawn across the plot area (background) 
to help the reader judge the position of 
the elements, e.g. the size of the column. 


The legend tells you the name of each 
data series in the chart. 


The data labels show you the actual 
figures in conjunction with the data 
points. 


A trendline shows you the trend of a 
particular data series, while error bars 
show you possible variations in figures. 


A data table details the chart figures 
below the data points in a table layout. In 
this example it includes the legend key. 


Text boxes and shapes (e.g. arrows) 
can be used to annotate charts or provide 
additional information. 

 

 

1 

2 

3 

4 

5 

6 

7 

8 

9 

6 



Microsoft Excel 2010 - Level 2 

© Watsonia Publishing Page 149 Charting Techniques 

ADDING A CHART TITLE 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

O
p

e
n

 

F
il

e
 Before starting this exercise you 

MUST open the file E829 
Charting Techniques_1.xlsx... 

 Click on the Projected Sales 
Chart worksheet tab to see the 
chart 

 This column chart shows sales 
projections, but without a title it’s 
a bit hard to work this out... 

 Click on the chart, then click on 
the Chart Tools: Layout tab to 
display the layout tools 

 Click on Chart Title  in the 

Labels group to display the 
options 

 Centred Overlay Title leaves the 
size of the plot area unchanged 
while Above Chart resizes the 
chart and places the title outside 
the plot area... 

 Select Centred Overlay Title 

 The chart title will appear at the 
top of the chart over the plot 
area... 

 Type Projected Sales Figures 
then press  

 The text appears in the Formula 
bar as you type and is placed in 
the Title text box when you press 

 

 

For Your Reference… 

To add a chart title: 

1. Click on Chart Title  in the Labels 

group on the Chart Tools: Layout tab 

2. Select a position option 

3. Type the title text and press  

Handy to Know… 

 You can remove a title by clicking on Chart 

Title  and selecting None. 

 There are only two pre-set placement 
options, but you can drag the title to any 
position you like. You can also edit it by 
clicking in the text box and making changes. 

3 

4 

The chart title tells the reader at a glance what 
the chart is about. It is effectively a summary of 
the purpose of the chart. Chart titles generally 
appear at the top of the chart where they don’t 

interfere with the plotted figures in the chart. Excel 
provides two pre-set title positions – one above the 
chart and one overlaid on the chart so that there is 
more room for the plot area. 
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ADDING AXES TITLES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
a

m
e

 

F
il

e
 

Continue using the previous 
file with this exercise, or open 
the file E829 Charting 
Techniques_2.xlsx... 

 If the Chart Tools: Layout tab 
is not displayed, click in the 
chart and then click on the tab 

 Click on Axis Titles , in 

the Labels group, then point to 
Primary Horizontal Axis Title 

 The options are displayed... 

 Select Title Below Axis to 
place a title below the chart 

 Type International Office and 

press  

 Click on Axis Titles  then 

point to Primary Vertical Axis 
Title to display the options 

 There are a few more 
alternatives for the vertical 
axis... 

 Select Horizontal Title 

 It will appear to the left of the 
chart and the plot area will 
resize to make room for it... 

 Type $AUD then press  

 

For Your Reference… 

To add axes titles: 

1. Click on Axis Titles  

2. Point to Primary Vertical Axis Title or 
Primary Horizontal Access Title 

3. Select the required option 

4. Type the title text then press  

Handy to Know… 

 You can remove an axis title by clicking on 
the title and pressing  or by clicking on 

Axis Titles , pointing to Primary 

Vertical Axis Title or Primary Horizontal 

Access Title and selecting None. 

2 

3 

Axes titles appear outside the vertical (y) axis 
and the horizontal (x) axis and are used to 
provide units of measure or an overall text 
description of the data elements plotted on each 

axis. For example, if your vertical axis shows dollar 
amounts, you can detail which currency you’ve 
used by adding a vertical axis title. 

4 
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POSITIONING THE LEGEND 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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Continue using the previous 
file with this exercise, or open 
the file E829 Charting 
Techniques_3.xlsx... 

 If the Chart Tools: Layout tab 
is not displayed, click on the 
chart and then click on the tab 

 Currently, the legend is 
positioned on the right... 

 Click on Legend , in the 

Labels group, to display the 
options 

 Select Show Legend at Top 

 The legend will move to behind 
the title and the plot area will 
widen... 

 Click on the legend so that 
pale blue handles appear 
around it 

 Point to the line anywhere 
between the top handles, then 
drag the legend down below 
the heading 

 You can actually position the 
legend wherever you want to. 
We’ll put it back near the data 
that it explains... 

 Click on Legend  then 

select Show Legend at Right 

 

For Your Reference… 

To position a legend: 

1. On the Chart Tools: Layout tab, click on 

Legend  

2. Select a position option 

Handy to Know… 

 If a legend is not displayed, you can create 

one by clicking on Legend  and 

selecting any of the legend position options. 

 You can remove a legend by clicking on it 
and pressing  or by clicking on 

Legend  and selecting None. 

3 

4
2 

A legend is a list of the data series that have 
been plotted on a chart along with their 
corresponding colours or other identifying marks. 
By default, charts are created with a legend that 

appears to the right of and outside the plot area. 
There are six pre-set position options for you to 
select from, some overlaying the plot area, others 
being placed outside the plot area. 
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SHOWING DATA LABELS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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Continue using the previous 
file with this exercise, or open 
the file E829 Charting 
Techniques_4.xlsx... 

 If the Chart Tools: Layout tab 
is not displayed, click on the 
chart, then click on the tab 

 At the moment the columns 
show you roughly how large 
the number is, but no detail... 

 Click on Data Labels , in 

the Labels group and select 
Centre 

 The actual figures will appear 
across the centre of the 
columns. Unfortunately some 
overlap a little... 

 Click on the figure in the green 
column (Mar) for Auckland 

 All the figures in that data 
series will be selected... 

 Point to the middle of the 
number then drag it down a 
little so that it no longer 
overlaps the previous figure 

 Repeat steps 3 and 4 to adjust 
the position of the data label 
for Feb (red) for New York 

 

For Your Reference… 

To show data labels: 

1. On the Chart Tools: Layout tab, click on 

Data Labels  

2. Select the required position 

Handy to Know… 

 You can remove data labels by clicking on 

Data Labels  and selecting None. 

2 

3 

Data labels are text boxes placed on the chart 
that show the actual figures behind the chart. 
Data labels can show the value, the category 
label or the percentage of a total. They are 

particularly useful for pie charts as they can be 
used to show the exact percentage of each slice. 
Data labels can be placed in several pre-set 
positions on the chart. 

5 
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SHOWING A DATA TABLE 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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Continue using the previous 
file with this exercise, or open 
the file E829 Charting 
Techniques_5.xlsx... 

 If the Chart Tools: Layout tab 
is not displayed, click on the 
chart, then click on the tab 

 At the moment, the data is 
shown in the columns as data 
labels. You can also show it 
outside the plot area in a 
table... 

 Click on Data Table , in 

the Labels group, to display 
the options 

 The data table is always 
positioned below the chart, but 
you can decide whether or not 
to display the legend keys... 

 Select Show Data Table with 
Legend Keys 

 The data table will be added. 
The individual data labels are 
now redundant... 

 Click on Data Labels  and 

select None 

 The data now only appears 
below the chart. We’ll leave 
the existing legend in place 

 

For Your Reference… 

To show a data table: 

1. Click on Data Table  

2. Select an option 

Handy to Know… 

 To remove a data table, click on Data Table 

 and select None. 

 You can format the data in a data table by 
clicking in the data table and then applying 
the required formatting using the controls on 

the Home tab. 

1 

4 

A data table, in reference to charts, is a table of 
the figures used to create the chart. It allows you 
to report both the data and the chart in one place. 
A data table is only ever placed below the chart 

itself, and the figures are aligned with their 
corresponding data point or column in the chart – 
unless you create a horizontal bar chart. You can 
choose to include legend keys if you like. 
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MODIFYING THE AXES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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Continue using the previous 
file with this exercise, or open 
the file E829 Charting 
Techniques_6.xlsx... 

 If the Chart Tools: Layout tab 
is not displayed, click on the 
chart, then click on the tab 

 On this chart, the horizontal 
axis is obscured by the data 
table, so any changes you 
make will not be visible. 
However, you can examine the 
options and make changes to 
the vertical axis which 
currently shows the default 
axis settings... 

 Click on Axes , in the 

Axes group, to display the 
submenu, then point to 
Primary Horizontal Axis to 
see the options 

 Point to Primary Vertical Axis 
to see these options 

 Select Show Axis in 
Thousands 

 The number of zeros in each 
major unit will be reduced and 
the label Thousands will 
appear 

 

For Your Reference… 

To modify the axis: 

1. Click on Axes  

2. Point to Primary Horizontal Axis and 
Primary Vertical Axis 

3. Select an option 

Handy to Know… 

 You can modify the Axis Options by clicking 

on Axes , pointing to Primary 

Horizontal Axis and selecting More 
Horizontal Axis Options or pointing to 
Primary Vertical Axis and selecting More 

Vertical Axis Options. 

1 

3
2 

The axes show the values and labels for the 
charted data. By default, the values appear on 
the left-hand side of the chart (vertical axis) and 
the labels appear across the bottom of the chart 

(horizontal axis). The position of the major units on 
these axes is calculated by Excel, but you can 
select alternative layouts and scales and even 
remove them altogether if you want to. 

4 
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SHOWING GRIDLINES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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Continue using the previous 
file with this exercise, or open 
the file E829 Charting 
Techniques_7.xlsx... 

 If the Chart Tools: Layout tab 
is not displayed, click on the 
chart, then click on the tab 

 At the moment, only the 
horizontal gridlines are 
displayed and these align with 
the major units... 

 Click on Gridlines , in the 

Axes group, and point to 
Primary Horizontal Gridlines 
to display the menu 

 Notice that Major Gridlines is 
selected... 

 Point to Primary Vertical 
Gridlines to display the menu 

 Notice that None is currently 
selected... 

 Select Major Gridlines to 
apply vertical gridlines to the 
chart 

 In this case they make the 
chart a little busy and don’t 
add much value, but at least 
you can see how they work 

 

For Your Reference… 

To show gridlines: 

1. On the Chart Tools: Layout tab, click on 

Gridlines  in the Axes group 

2. Point to Primary Horizontal Gridlines or 
Primary Vertical Gridlines 

3. Select an option 

Handy to Know… 

 To remove gridlines, click on Gridlines , 

point to Primary Horizontal Gridlines or 
Primary Vertical Gridlines and select 

None. 

1 

3 

Many of Excel’s chart types include major 
gridlines by default. Gridlines help you to 
determine the numeric value of each data point 
and are therefore very useful when the absolute 

size of the data value is important. You can show 
or hide horizontal and vertical gridlines and decide 
whether to display them for major and/or minor 
units. 

4 
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FORMATTING THE PLOT AREA 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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Continue using the previous 
file with this exercise, or open 
the file E829 Charting 
Techniques_8.xlsx... 

 If the Chart Tools: Layout tab 
is not displayed, click on the 
chart, then click on the tab 

 Currently, the plot area 
(background) is clear... 

 Click on Plot Area , in the 

Background group, to display 
the options 

 Currently, there is no fill set... 

 Select Show Plot Area 

 Nothing happens because the 
default fill is white... 

 Click on Plot Area  and 

select More Plot Area 
Options to display the Format 
Plot Area dialog box 

 The Fill category settings are 
displayed... 

 Click on Gradient fill then 
click on [Close] 

 The plot area of the chart is 
now filled with a blue gradient 

 

For Your Reference… 

To format the plot area: 

1. On the Chart Tools: Layout tab, click on 

Plot Area  

2. Select More Plot Area Options 

3. Make the required selections 

4. Click on [Close] 

Handy to Know… 

 To return the plot area to the default fill 

colour, click on Plot Area  and select 

Show Plot Area. 

 To remove the plot area fill, click on Plot 

Area  and select None. 

1 

2 

The plot area is the area between the axes in 
which the data is plotted. You can also think of it 
as the chart background. Depending upon the 
default format of the chart you choose, the plot 

area may be white, but you can select from a range 
of colours, textures or images to fill the plot area. 
This can enhance charts if you plan to use them for 
presentations. 

5 



Microsoft Excel 2010 - Level 2 

© Watsonia Publishing Page 157 Charting Techniques 

ADDING A TRENDLINE 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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Continue using the previous 
file with this exercise, or 
open the file E829 Charting 
Techniques_9.xlsx... 

 If the Chart Tools: Layout 
tab is not displayed, click on 
the chart, then click on the 
tab 

 Click on Trendline , in 

the Analysis group, to 
display the options 

 The options include various 
calculation methods for 
trends... 

 Select Linear Trendline 

 The Add Trendline dialog 
box will appear so that you 
can select a particular 
month... 

 Click on Mar, then click on 
[OK] 

 A trendline will be added to 
your chart and the trendline 
information will be added to 
the legend 

 

For Your Reference… 

To add a trendline: 

1. Click on Trendline  

2. Select an option 

3. Click on the data series you want to create a 
trend from 

4. Click on [OK] 

Handy to Know… 

 You can add a trendline to a data series in 
unstacked, 2-D, area, bar, column, line, 
stock, xy (scatter), or bubble charts. You 
can’t add trendlines to data series in stacked, 
3-D, radar, pie, surface, or doughnut charts. 

2 

3 

A trendline is used to depict the trend, showing 
an average figure for the values that the chart is 
built on and building a prediction of what the 
values are likely to be. Trendlines show the 

general direction of results and the expected 
direction of future results. There are six trend types 
to select from, being linear, logarithmic, polynomial, 
power, exponential and moving average. 

4 
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ADDING ERROR BARS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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Continue using the previous 
file with this exercise, or 
open the file E829 Charting 
Techniques_10.xlsx... 

 If the Chart Tools: Layout 
tab is not displayed, click on 
the chart, then click on the 
tab 

 Error bars appear at the top 
of each column or data 
point. Currently they aren’t 
shown... 

 Click on Error Bars , in 

the Analysis group, to 
display the options 

 Select Error Bars with 
Standard Error 

 The error bars will be 
placed on the chart and the 
chart will adjust accordingly 

 

For Your Reference… 

To add error bars: 

1. On the Chart Tools: Layout tab, click on 

Error Bars  

2. Select an option 

Handy to Know… 

 You can access all of the error bar options by 

clicking on Error Bars  and selecting 

More Error Bars Options. 

 You can remove error bars by clicking on 

Error Bars  and selecting None. 

1 

3 

Error bars are graphical representations of 
possible error ranges in figures. The error bar is 
placed at the data point to show the possible 
variations in value. For example, you could use 

error bars to reflect a potential 2% positive and 
negative variation in sampling results. There are 
four options for error bars, being fixed value, 
standard error, percentage and standard deviation. 
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ADDING A TEXT BOX TO A CHART 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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Continue using the previous 
file with this exercise, or 
open the file E829 Charting 
Techniques_11.xlsx... 

 If the Chart Tools: Layout 
tab is not displayed, click on 
the chart, then click on the 
tab 

 Click on Text Box  in the 

Insert group, then move the 
mouse pointer between the 
columns for Auckland and 
Dublin 

 The mouse pointer will 
change to an insertion point. 
A tool tip will tell you which 
part of the chart you are 
located over... 

 Click and type Anomaly 
due to fuel shortage 

 Drag the right-hand, middle 
handle to the right so that it 
fits the text 

 Drag up the bottom, middle 
handle so that it fits the text 

 Drag the text box to centre it 
between the vertical 
gridlines, then click in a 
blank area of the chart to 
deselect it 

 

For Your Reference… 

To add a text box: 

1. On the Chart Tools: Layout tab, click on 

Text Box  

2. Click on the chart and type the text 

3. Resize and reposition the text box if 
necessary 

Handy to Know… 

 You can also add a text box to a chart by 

clicking on Shapes  and clicking on the 

Text Box which is the first icon on the left. 

Shapes  is found on the Chart Tools: 

Layout tab and the Insert tab. Text Box  

is also found on the Insert tab. 

2 

6 

There may be times when, no matter which chart 
layout element you look at, none of them actually 
add the information to the chart that you need. In 
these situations you can use a text box and type 

whatever you want to. Text boxes can be placed 
anywhere on the chart, so you can use them to add 
subtitles, author notes, explanations, copyright 
information and so on. 
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DRAWING SHAPES IN A CHART 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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Continue using the previous 
file with this exercise, or open 
the file E829 Charting 
Techniques_12.xlsx... 

 If the Chart Tools: Layout tab 
is not displayed, click on the 
chart, then click on the tab 

 Click on Shapes , in the 

Insert group, to display the 
options, then point to the third 
shape from the left in the top 
row 

 The tool tip will tell you that it’s 
an arrow... 

 Click on Arrow then hover 
over the bottom edge of the 
text box 

 Red squares will help you line 
up with the middle of the text 
box... 

 Hold down , then point to 

the bottom, centre, red square 
and click-and-drag straight 
down to draw an arrow 

  ensures that you draw a 

straight line... 

 Drag the arrow across slightly, 
if you need to, to align it with 
the error bar 

 Click on another part of the 
chart to deselect the arrow 

 

For Your Reference… 

To draw a shape on a chart: 

1. In the Chart Tools: Layout tab, click on 

Shapes  

2. Click on the required shape 

3. Move onto the chart, then click-and-drag to 
draw the shape 

Handy to Know… 

 Text can be added to shapes by right-clicking 
on the shape and selecting Edit Text. 

 Shapes can be deleted by clicking on the 
shape to select it and pressing . 

3 

6 

You can add shapes to charts to provide 
additional information, to point to specific figures, 
to indicate anomalies or just for decoration. There 
are over 160 shapes to choose from, each of 

which can be resized and tweaked, including lines, 
rectangles, basic shapes, block arrows, equation 
shapes, flowchart shapes, stars and banners, and 
callouts. 

Note: This chart has too many details and additions to be 
practical, but illustrates the types of elements that you can 
use to enhance charts. In reality, you would only use some 
of these elements and keep the layout simple and 
uncluttered. 


